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Введение

Данное руководство демонстрирует возможности измерительных приложений 
N6153A и W6153A, перечисленных на странице 2. Каждая демонстрация пред-
ставляет краткое описание функций приложения и соответствующих операций, 
выполняемых на генераторе и/или анализаторе сигналов.
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Доступ ко всем определенным в 
стандарте DVB-T/H/T2 измерениям 
ВЧ параметров передатчика, а также 
к широкому диапазону дополнитель-
ных функций измерения и анализа 
открывается нажатием одной кнопки 
(табл. 1). Этими измерениями можно 
управлять дистанционно по шине 
IEC/IEEE или по локальной сети с 
помощью команд SCPI.

Измерения аналоговых параметров 
модуляции можно выполнять с 
помощью анализаторов сигналов 
PXA или MXA с установленным 
модулем BBIQ. Поддерживаемые 
измерения модулирующего сигнала 
включают качество модуляции, 
комплементарную интегральную 
функцию распределения мощности и 
параметры сигналов IQ.

Таблица 1. Однокнопочные измерения, предлагаемые  
измерительным приложением N/W6153A

Технология DVB-T/H DVB-T2

Измерительное приложение N6153A-2FP, 
W6153A-2FP

N6153A-3FP, 
W6153A-3FP

Анализатор серии Х PXA, MXA, EXA, 
CXA

PXA, MXA, 
EXA, CXA

Измерения

Мощность в канале • •

Ослабление в боковой полосе • •

Маска спектра с аналоговым ТВ в соседнем канале • •

Мощность в соседнем канале • •

Маска излучаемого спектра • •

Комплементарная интегральная функция распределения мощ-
ности 

• •

Паразитное излучение • •

Точность модуляции

Среднеквадратическая амплитуда вектора ошибок, % • •

Пиковая амплитуда вектора ошибок, % • •

Положение пика амплитуды вектора ошибок • •

Среднеквадратический коэффициент ошибок модуляции, дБ • •

Пиковый коэффициент ошибок модуляции, дБ • •

Положение пика коэффициента ошибок модуляции • •

Среднеквадратическая ошибка амплитуды, % • •

Пиковая ошибка амплитуды, % • •

Положение пика ошибки амплитуды • •

Среднеквадратическая ошибка фазы, град. • •

Пиковая ошибка фазы, град. • •

Положение пика ошибки фазы • •

Погрешность частоты, Гц • •

Погрешность тактовой частоты, Гц • •

Мощность передачи, дБм • •

Разбаланс амплитуды • •

Квадратурная ошибка, град. • •

Фазовый джиттер, рад. •

Подавление несущей, дБ •

С/Ш, дБ •

Отношение мощности TPS, дБ •

Отношение мощности данных, дБ •

Зависимость коэффициента ошибок модуляции/амплитуды 
вектора ошибок от поднесущих/частоты

• •

Коэффициент ошибок модуляции данных, дБ • •

Коэффициент ошибок модуляции пилот-сигнала/TPS, дБ • •

Коэффициент ошибок модуляции пилот-сигнала P2 / L1-Pre / 
L1-Post / пилот-сигнала Cont / пилот-сигнала Scat / пилот-сиг-
нала FC

•

Зависимость амплитуды от поднесущих, дБ • •

Зависимость фазы от поднесущих, град. • •

Зависимость групповой задержки от поднесущих, нс • •

Импульсная характеристика канала, дБ • •

Результаты измерения коэффициента ошибок на бит •

Декодирование TPS •

Сигнализация L1 •

Мониторинг коэффициента ошибок модуляции • •

Подробнее  
об измерениях



4 

Полезный совет:

Обновите микропрограммное обеспечение прибора и прикладное про-
граммное обеспечение до последних версий, которые можно найти на 
страницах:

www.keysight.com/find/xseries_software

www.keysight.com/find/signalstudio

Подготовка демонстрации

Минимальные требования 
к оборудованию

В приведенной ниже демонстрации 
используются анализатор сигналов 
серии Х и векторный генератор сиг-
налов N5182A MXG. Наименования 
клавиш, заключенные в квадратные 
скобки [ ], соответствуют клавишам 
передней панели, а наименования, 
заключенные в фигурные скобки { }, 
соответствуют программным клави-
шам на дисплее.

Тип прибора 
или ПО

Номер модели Необходимые опции

Векторный гене-
ратор сигналов 
MXG

N5182A
(версия микропрограмм-
ного обеспечения A.01.20 
или старше)

-- 651, 652 или 654 – встроенный генератор моду-
лирующего сигнала (30/60/125 Mвыб/с, 8 Мвыб)

-- 019 – расширение памяти генератора модулиру-
ющего сигнала до 64 Мвыб (рекомендуется)

ПО Signal Studio 
для цифрового 
видео

N7623B QFP или QTP 
Advanced DVBT/H/C/J.83 
A/C 
N7623B ZFP или ZTP 
Advanced DVB-T2 (версия 
ПО: 2.2.7.0 или старше)

Посетите страницу N7623B Signal Studio и про-
верьте наличие новых версий
www.keysight.com/find/signalstudio

Анализатор сиг-
налов серии Х

N9000A1, N9010A, N9020A 
или N9030A
версия микропрог
раммного обеспечения 
A.07.xx или старше

Рекомендуется:
-- EA3 – электронный аттенюатор 3,6 ГГц
-- POx – предусилитель
-- P0x (P03, P08 (P07 для CXA))
-- B25 – полоса анализа 25 МГц (для расширения 

полосы анализа с 10 до 25 МГц)
-- BBA – входы аналогового сигнала IQ (для анали-

за аналогового модулирующего сигнала IQ)
Необходимо:
-- 503, 508, 507 (EXA и CXA), 513 или 526–513 и 526 

для CXA недоступны

Решение для 
цифрового видео 
DVB-T/H серии X

Только N6153A – N9010A, 
N9020A, N9030A 
W6153A – N9000A

Необходимо:
-- 2FP: измерительное приложение DVB-T/H, 

фиксированная бессрочная лицензия
-- 3FP: измерительное приложение DVB-T2, фикси-

рованная бессрочная лицензия
ИЛИ
-- 2TP: измерительное приложение DVB-T/H, пере-

носимая лицензия
-- 3TP: измерительное приложение DVB-T2, пере-

носимая лицензия

Управляющий 
ПК с ПО Signal 
Studio для циф-
рового видео1

С установленным ПО N7623B для создания 
и загрузки сигналов в Keysight MXG чрез GPIB или 
по сети (TCP/IP) – описание установки и настройки 
приведено в онлайновой документации.

1.	 В качестве управляющего ПК для установки ПО N7623B Signal Studio и загрузки сигналов в MXG 
через LAN или GPIB можно использовать анализаторы сигналов PXA/MXA/EXA/CXA серии Keysight X.
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ПО N7623B Signal 
Studio для цифрово-
го видео

Опорная частота 
10 МГц

LAN/GPIB

ВЧ 
выход 
MXG

ВЧ вход 
анализатора 
сигналов 
серии Х

Рис. 1. Схема демонстрации

СХеМА ДеМОНСТРАцИИ

Соедините ПК, анализатор серии Х и генератор MXG

Соедините ПК (с установленным 
программным обеспечением Keysight 
N7623B Signal Studio для цифро-
вого видео и библиотеками ввода/
вывода Keysight) с генератором 
N5182A MXG через интерфейс GPIB 
или LAN. Выполните подключения 
согласно описанию, приведенному 
в руководстве на ПО Signal Studio, 
а затем проделайте следующее для 
подключения анализатора серии Х 
(схема показана на рис. 1):

A.  Подключите выходной ВЧ порт 
MXG к входному ВЧ порту анали-
затора сигналов серии Х

B.  Подключите выход MXG 10 МГц к 
входному порту опорной частоты 
анализатора сигналов серии Х 
(на задней панели)
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Демонстрации

Демонстрация 1

Настройка ПО Signal Studio для 
цифрового видео на создание 
сигналов DVB-T/H/T2

ПО Keysight N7623B Signal Studio для 
цифрового видео представляет собой 
приложение для операционной систе-
мы Windows®, которое упрощает соз-
дание стандартных или специальных 
сигналов DVB-T/H и DVB-T2. Созданные 
сигналы загружаются в векторный 
генератор сигналов MXG, который 
генерирует сигналы ВЧ или IQ.

Установите следующие параметры 
для испытательных сигналов DVB-T/H 
и DVB-T2:

Параметры DVB-T/H

Стандарт:	 DVB-T

Частота:	 474 МГц

Ширина канала:	 8 МГц

Размер БПФ:	 2 K

Тип модуляции:	 16QAM

Альфа:	 1

Защитный интервал (GI):	 ¼

Режим передачи:	 Иерархический

Скорость кодирования  
HP/LP:	 ½

Параметры DVB-T2 (сигнал PLP)

Тип P1:	 SISO

Частота:	 474 МГц

Ширина канала:	 8 МГц

Тип PAPR:	 Без PAPR

Защитный интервал (GI):	 1/128

Размер БПФ:	 32 K

Пилотная последова- 
тельность:	 PP7

Режим несущей:	 Расширенный

Число символов данных:	 7

Тип модуляции L1:	 64QAM

Число фреймов  
на суперфрейм:	 2

Параметры PLP

Формат модуляции:	 256QAM

Поворот сигнального  
созвездия:	 Включен

Тип FEC:	 Нормальный (64 К)

Скорость кодирования  
LDPC:	 3/5

Число блоков TI для  
чередования фреймов:	 3

Число блоков FEC:	 26

Операции Нажатия клавиш

На MXG:

Выполните предварительную 
установку

[Preset]

Проверьте IP адрес [Utility] {I/O Config} {LAN Setup}

В ПО Signal Studio:

Запустите Keysight Signal 
Studio для цифрового видео

Дважды щелкните на ярлыке Digital Video на рабочем столе или 
запустите программу через меню Пуск системы Windows.

Проверьте взаимодействие 
программы с прибором по 
GPIB или LAN (TCP/IP)

Для установки нового соединения щелкните в верхней части 
окна Signal Studio на меню {System}. Затем выберите {Run 
System Configuration Wizard}

Для генерации сигналов DVB-T/H:

Выберите формат DVB-T/H Щелкните в верхней части окна Signal Studio на меню {Format}. 
Затем выберите {DVB-T/H}

Настройте генератор сиг-
налов следующим образом: 
центральная частота 474 МГц, 
амплитуда –20 дБм, ВЧ выход 
включен, АРУ включена.

Щелкните на Signal Generator в левой части меню Проводника.
Номер модели прибора: N5162A/N5182A
Нажмите в верхней части зеленую кнопку [Preset].
Частота = 474 МГц, Амплитуда = –20 дБм,
RF Выход = On, ALC = On

Проверьте настройки сигнала 
с верхнего уровня

Щелкните на Waveform Setup и проверьте основные настройки 
сигнала, установите общие параметры DVB-T/H следующим 
образом:
Коэффициент передискретизации = 1,  
Зеркальный спектр = Выкл,
Настройка квадратурного угла = 0 град,
Баланс усиления I/Q = 0 дБ

Настройте испытательный 
сигнал для демонстрации

Щелкните на Carrier0 в Waveform Setup в левой части меню 
проводника. В правой части меню настройте параметры сигнала, 
который будет передаваться. На рис. 2 показаны параметры 
Signal Studio после настройки.

Для генерации сигналов DVB-T2:

Выберите формат DVB-T2 Щелкните в верхней части окна Signal Studio на меню {Format}. 
Затем выберите {DVB-T2}

Настройте генератор сиг-
налов следующим образом: 
центральная частота 474 МГц, 
амплитуда –20 дБм, ВЧ выход 
включен, АРУ включена.

Щелкните на Signal Generator в левой части меню Проводника.
Номер модели прибора: N5162A/N5182A
Нажмите в верхней части зеленую кнопку [Preset].
Частота = 474 МГц, Амплитуда = –20 дБм,
RF Выход = On, ALC = On

Проверьте настройки сигнала 
с верхнего уровня

Щелкните на Waveform Setup и проверьте основные настройки 
сигнала, установите общие параметры DVB-T2 следующим 
образом:
Коэффициент передискретизации = 1,  
Зеркальный спектр = Выкл,
Настройка квадратурного угла = 0 град,
Баланс усиления I/Q = 0 дБ

Настройте общие параметры 
DVB-T2 для несущей 0

Щелкните на Carrier0 в Waveform Setup в левой части меню 
проводника. В правой части меню настройте параметры сигнала, 
который будет передаваться. Настройки Carrier0 должны выгля-
деть, как на рис. 3.

Настройте параметры PLP0 Щелкните на PLP0 в Carrier0 в левой части меню проводника. 
В правой части меню установите параметры в соответствии с 
параметрами исследуемого сигнала. Настройки PLP0 должны 
выглядеть, как на рис. 4.

Загрузите и сохраните параметры:

Загрузите сигнал в MXG Щелкните в верхней панели инструментов на . Если возникнет 
ошибка, обратитесь в онлайновую справку ПО Signal Studio.

Сохраните файл сигнала для 
последующего использо-
вания

File > Save Setting File > DVB.scp (имя создаваемого файла)

Экспортируйте файл сигнала 
для последующего исполь-
зования

File > Export Waveform Data > DVB.wfm (имя создаваемого файла)
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Рис. 2. Параметры сигнала DVB-T/H в ПО Keysight Signal Studio

Рис. 3. Параметры Несущей 0 для сигнала DVB-T2

Рис. 4. Параметры PLP 0 для сигнала DVB-T2
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Демонстрация 2

Мощность в канале

Измерение мощности в канале 
имеет три представления: ВЧ спектр, 
ослабление в боковой полосе и 
маска спектра.

Представление ВЧ спектра измеряет 
и показывает интегральную мощ-
ность в определенной полосе DVB-
T/H/T2 и спектральную плотность 
мощности (PSD) в дБм/Гц или дБм/
МГц.

Представление ослабления в боко-
вой полосе используется для оценки 
линейности сигнала OFDM без учета 
маски спектра.

Представление маски спектра 
сравнивает входной сигнал с маской 
спектра, определенной в стандарте 
ETSI EN 300 744 для условий, когда 
в соседнем канале присутствует 
сигнал аналогового ТВ.

Рис. 5. Измерение мощности в канале с представлением ВЧ спектра

Рис. 6. Измерение мощности в канале с представлением ослабления в 
боковой полосе

Операции Нажатия клавиш

На анализаторе серии X:

Выберите режим DVB-T/H с T2 [Mode] {DVB-T/H with T2}

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите режим DVB-T и установите ширину 
канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Выберите измерение мощности в канале 
(стандартное измерение для ВЧ спектра)

[Meas] {Channel Power}

Переключитесь в представление ослабления 
в боковой полосе

[View/Display] {Shoulder Attenuation}
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Рис. 7. Схема измерения маски спектра передатчика DVB-T/H/T2 с выходным 
фильтром

Рис. 8. Схема измерения маски спектра передатчика DVB-T/H/T2 с внешним 
фильтром

Представление маски спектра

Динамический диапазон ВЧ выхода 
реального передатчика DVB-T/H с T2 
обычно превышает динамический 
диапазон анализатора. Поэтому пря-
мое измерение всегда дает ошибку 
и не отражает реального выходного 
ВЧ сигнала.

Существуют два метода измерения 
маски спектра ВЧ выхода пере-
датчика.

Метод 1. Если передатчик DVB-T/H/
T2 имеет выходной фильтр, исполь-
зуется схема измерения маски 
спектра, показанная на рис. 7.

Для измерения маски спектра нужно 
проделать три операции:

A.	 Измерьте АЧХ выходного филь-
тра с помощью анализатора 
цепей или с помощью генерато-
ра и анализатора сигналов.

B.	 Измерьте сигнал в точке А, как 
показано на рис. 7.

C.	 	Скорректируйте значение, полу-
ченное на шаге В, с учетом АЧХ 
фильтра, измеренной на шаге А.

Метод 2. Если передатчик не 
имеет выходного фильтра, к его 
выходу следует подключить 
внешний режекторный фильтр. 
Соответствующая схема измерения 
показана на рис. 8.

Для измерения маски спектра нужно 
проделать следующие операции:

A.	 	Измерьте АЧХ выходного 
фильтра с помощью анализатора 
цепей или с помощью генерато-
ра и анализатора сигналов.

B.	 Измерьте сигнал в точке B, как 
показано на рис. 8.

C.	 Скорректируйте значение, полу-
ченное на шаге В, с учетом АЧХ 
фильтра, измеренной на шаге А.

Обычно поправочные данные пред-
ставляются в виде таблицы частот-
ной характеристики фильтра в дБ 
с несколькими значениями частоты 
в пределах диапазона.

Обычно поправочные данные 
представляются в виде таблицы 
отрицательных значений частотной 
характеристики режекторного филь-
тра в дБ с несколькими значениями 
частоты в пределах диапазона.

Возбудитель 
COFDM Усилитель

Выходной 
фильтр

Входной 
сигнал

Анализатор 
сигналов Аттенюатор

Передатчик DVB-T/H/T2 (тестируемое устройство)

ВЧ выход

A

Усилитель
Внешний 
фильтр

Входной 
сигнал
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Операции Нажатия клавиш

На анализаторе серии X:

Выберите представление маски спектра [View/Display] {Spectrum Mask}

Введите значение ослабления (для реаль-
ного передатчика DVB-T)

[Input/Output] {External Gain} {Ext Preamp}

Вызовите или отредактируйте таблицу 
поправок

[Input/Output] {More 1 of 2} {Corrections} {Edit} или 
[Recall] {Data}

Включите коррекцию [Input/Output] {More 1 of 2} {Corrections} {On}

Рис. 9. Измерение мощности в канале с помощью представления маски 
спектра до коррекции амплитуды

Рис. 10. Измерение мощности в канале с помощью представления маски 
спектра после коррекции амплитуды

Примечание. Если в представлении 
маски спектра полоса не равна 
8 МГц, трасса маски не отобра-
жается и выводится сообщение 
«Результатов нет», поскольку в 
настоящий момент маска спектра 
для таких случаев в спецификациях 
не определена.
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Демонстрация 3

Мощность в соседнем канале (ACP)

Функция измерения мощности в 
соседнем канале позволяет изме-
рять и отображать мощность в одном 
или нескольких каналах передачи. 
Текстовое окно показывает общую 
мощность в определенной полосе 
несущей с заданными отстройками 
частоты с обеих сторон от частоты 
несущей. Результаты измерения ACP 
должны выглядеть примерно так, 
как показано на рис. 11.

Рис. 11. Измерение ACP с включенной коррекцией шума

Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите режим DVB-T и установите ширину 
канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Выберите измерение мощности в соседнем 
канале

[Meas] {ACP}

Сравните результаты измерения, полученные 
при включенной и выключенной коррекции 
шума (по умолчанию она отключена). Лучшее 
значение ACP получается при включенной 
коррекции шума (рис. 11).

[Meas Setup] {More 1 of 2}
{Noise Correction On}
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Демонстрация 4

Комплементарная интегральная 
функция распределения мощности

Комплементарная интегральная 
функция распределения мощности 
(CCDF) представляет собой стати-
стический метод, используемый для 
интерпретации отношения пиковой 
мощности к средней мощности 
шумоподобных сигналов с циф-
ровой модуляцией. Это основной 
параметр, используемый для проек-
тирования усилителей передатчи-
ков DVB-T/H/T2, который особенно 
сложно реализовать, поскольку 
усилитель должен справляться с 
высокими отношениями пиковой 
мощности к средней, сохраняя при 
этом малое значение коэффициента 
утечки мощности в соседний канал.

Рис. 12. Измерение комплементарной интегральной функции распреде-
ления мощности

Рис. 13. Измерение комплементарной интегральной функции распределе-
ния мощности с эталонной трассой

Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите тестируемый радиостандарт 
и ширину канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Активируйте измерение комплементарной 
интегральной функции распределения 
мощности

[Meas] {Power Stat CCDF}

Сохраните эталонную трассу [Trace/Detector] {Store Ref Trace}

Включите эталонную трассу [Trace/Detector] {Ref Trace On}
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Демонстрация 5

Маска излучаемого спектра

Измерение маски излучаемого 
спектра (SEM) позволяет сравнить 
общий уровень мощности в пределах 
определенной полосы несущей и 
заданной отстройкой в обе стороны 
от несущей частоты с уровнями, 
допускаемыми стандартом в при-
сутствии сигнала цифрового ТВ в 
соседнем канале. Это измерение 
используется при проектировании 
усилителей передатчиков DVB-T/H/
T2 и является ключевым измере-
нием, определяющим линейность 
усилителя и другие характеристики 
при проверке на соответствие самым 
строгим системным требованиям.

Подробное пояснение измерения 
маски излучаемого спектра приведе-
но в разделе с описанием измерения 
мощности в канале и представления 
маски спектра.

Примечание. Если при измерении 
маски излучаемого спектра полоса 
не равна 7 или 8 МГц, трасса маски 
отображается в виде горизонтальной 
линии в верхней части экрана. После 
этого трассу маски можно отобра-
зить в ручном режиме командами 
[Meas Setup] {Offset/Limit}.

Примечание. Если не указано особо, 
нужно использовать сценарий 
измерения передаваемого сигнала 
вне предельных режимов работы; 
сценарий с предельными режимами 
работы используется, если теле-
визионные каналы соседствуют с 
другими службами (с передатчиками 
малой мощности или с приемными 
каналами, чувствительными к 
помехам).

Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите тестируемый радиостандарт 
и ширину канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Активируйте измерение маски излучаемого 
спектра (по умолчанию используется сцена-
рий вне предельных режимов)

[Meas] {Spectrum Emission Mask}

Введите значение ослабления (для реально-
го передатчика DVB-T)

[Input/Output] {External Gain} {Ext Preamp}

Вызовите или отредактируйте таблицу 
поправок

[Input/Output] {More 1 of 2} {Corrections} {Edit} 
или [Recall] {Data}

Включите коррекцию [Input/Output] {More 1 of 2} {Corrections} {On}

Измерьте маску излучаемого спектра в сце-
нарии с предельными режимами

[Meas Setup] {Limit Type} {Critical}
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Рис. 14. Измерение маски излучаемого спектра в сценарии вне предельных режи-
мов после коррекции амплитуды

Рис. 15. Измерение маски излучаемого спектра в сценарии с предельными режима-
ми после коррекции амплитуды
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Демонстрация 6

Точность модуляции DVB-T/H

Измерение точности и качества 
модуляции необходимо в соот-
ветствии с требованиями к тестиро-
ванию, определенными в стандарте 
DVB-T/H, для гарантии правильной 
работы передатчиков. Измерения 
амплитуды вектора ошибки (EVM) и 
коэффициента ошибок модуляции 
(MER) определены в DVB-T/H 
для описания общего ухудшения 
сигнала, включая шум, помехи или 
искажения на входе декодера стан-
дартного приемника, для оценки 
способности приемника правильно 
декодировать сигнал. Параметр 
EVM используется для оценки 
качества модуляции и широко 
применяется в цифровой связи. 
MER представляет разность между 
измеренными и теоретическими 
положениями точек сигнального 
созвездия, что характеризует шум, 
помехи и искажения сигнала. 
Обычно MER используется в 
широковещательных приложениях. 
Значения MER и EVM можно выве-
сти одно из другого.

Функция измерения точности 
модуляции DVB-T/H в анализаторах 
серии Keysight X предлагает 
множество методов измерения 
ошибок передатчика DVB-T/H. 
Можно измерять EVM, MER, ошибку 
амплитуды, ошибку фазы и многие 
другие параметры.

Доступные представления и трассы 
в режиме измерения точности 
модуляции:

-- Представление измерения I/Q 
в полярных координатах (рис. 
16): представление измеренных 
данных I/Q выбранных 
поднесущих

–– Метрики результатов (слева)

–– Полярная диаграмма 
измерения I/Q (справа)

-- Представление ошибки I/Q (рис. 
17): представление рассчитанного 
вектора ошибки между соответ-
ствующими точками символов в 
измеренном и эталонном сигналах 
I/Q

–– Представление зависимости 
MER/EVM от поднесущей/
частоты (вверху слева)

–– Спектр (вверху справа)

–– Полярная диаграмма 
измерения I/Q (внизу слева)

–– Метрики результатов (внизу 
справа)

-- Представление АЧХ канала  
(рис. 18):

–– Зависимость амплитуды от 
поднесущей (вверху)

–– Зависимость фазы от 
поднесущей (в центре)

–– Зависимость групповой 
задержки от поднесущей 
(внизу)

-- Представление импульсной 
характеристики канала (рис. 19): 
представление состояния канала, 
состоящее из двух окон:

–– Таблица пиковых значений 
(слева)

–– Зависимость амплитуды от 
времени (справа)

-- Представление декодирования 
TPS (рис. 20): график 
декодирования TPS показывает 
исходные биты TPS и 
информацию, извлеченную из 
TPS.

-- Представление результатов 
измерения BER (рис. 21): сводка 
результатов BER в автономном 
режиме

-- Представление мониторинга MER 
(рис. 22): мониторинг результатов 
MER во времени с регистрацией 
подробной информации и необ-
работанных данных для ошибок 
MER

-- Представление метрик результа-
тов (рис. 23): сводка метрик всех 
результатов
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Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите тестируемый радиостандарт 
и ширину канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Активируйте измерение точности модуляции [Meas] {DVB-T/H Mod Accuracy}

Выберите опцию демодуляции [Mode Setup] {Auto Detect}

Выведите полярное представление 
измеренных данных I/Q и количественные 
показатели (рис. 16)

[View/Display] {IQ Measured Polar Graph}

Переключитесь в представление ошибки I/Q 
(рис. 17)

[View/Display] {I/Q Error (Quad View)}

Выведите АЧХ канала (рис. 18) [View/Display] {Channel Frequency Response} 
[Meas Setup] {Advanced} {Equalization On}

Выведите импульсную характеристику кана-
ла и включите выравнивание (рис. 19)

[View/Display] {Channel Impulse Response} [Meas 
Setup] {Advanced} {Equalization On}

Выведите декодирование TPS (рис. 20) [View/Display] {TPS Decoding}

Выведите результаты BER (рис. 21) [View/Display] {More 1 of 2} {BER Results}

Выведите результаты мониторинга MER (рис. 
22)

[View/Display] {More 1 of 2} {MER Monitor}

Выведите метрики результатов (рис. 23) [View/Display] {More 1 of 2} {Result Metrics}

Примечание 1. Если выполняется 
измерение точности модуляции 
DVB-T2, кнопки DVB-T и DVB-H 
становятся серыми. В этом случае 
перед изменением радиостандарта 
нужно переключиться на другое 
измерение.

Примечание 2. Чтобы отобразить 
значения подавления несущих 
в представлении ошибки I/Q, 
установите режим рассогласования 
I/Q в значение {Std} с помощью 
кнопок [Meas Setup] {Advanced} {I/Q 
Mismatch} {Std}.

Примечание 3. Окно таблицы 
пиковых значений в представлении 
импульсной характеристики канала 
очень полезно для идентификации 
наличия многолучевого распростра-
нения в канале. На рис. 24 показан 
пример канала с четырехлучевым 
распространением с соответствую-
щими задержками 0, 10, 20 и 30 мкс.

Примечание 4. Если в представ-
лении мониторинга MER включена 
граничная линия (Meas Setup, More 
1 of 2, MER Monitor) и текущее 
значение MER оказывается меньше 
этого предела, соответствующие 
необработанные данные IQ для 
этого измерения сохраняются в 
директории «D:\userdata\DVB-TH\
rawdata» и могут использоваться 
буфером захвата анализатора 
сигналов серии Х для дальнейшего 
исследования. Кроме того, в про-
цессе мониторинга создается файл 
журнала, включающий все значе-
ния MER, информацию о времени 
и путь к данным ошибки, который 
сохраняется в директории «D:\
userdata\DVB-TH».
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Рис. 16. Измерение точности модуляции с представлением 
измерения I/Q в полярных координатах

Рис. 17. Измерение точности модуляции с представлением ошибки I/Q

Рис. 18. Измерение точности модуляции с представлением 
АЧХ канала
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Рис. 20. Измерение точности модуляции с представлением 
декодирования TPS

Рис. 19. Измерение точности модуляции с представлением 
импульсной характеристики канала

Рис. 21. Измерение точности модуляции с представлением 
результатов BER
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Рис. 23. Измерение точности модуляции с представлением метрик 
результатов

Рис. 24. Канал с четырехлучевым распространением

Рис. 22. Представление мониторинга MER
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Демонстрация 7
Точность модуляции DVB-T2

Функция измерения точности 
модуляции DVB-T2 позволяет 
демодулировать сигналы DVB-T2, с 
измерением таких характеристик, 
как MER, EVM, ошибка амплитуды, 
ошибка фазы, информация о 
сигнализации L1 и т.п. Параметры 
демодуляции входного сигнала 
DVB-T2 могут определяться при-
бором автоматически по данным 
сигнализации L1 или могут устанав-
ливаться вручную.

В процессе демодуляции в качестве 
точки отсчета для синхронизации 
и демодуляции сигналов DVB-T2 
используется внутренний запуск с 
периодом, равным частоте фреймов 
DVB-T2.

Доступные представления и трассы 
в режиме измерения точности 
модуляции DVB-T2:

-- Представление измерения I/Q 
в полярных координатах (рис. 
25): представление измеренных 
данных I/Q для выбранных под-
несущих и индекса PLP.

–– Метрики результатов (слева): 
рассчитаны по общим данным

–– Полярная диаграмма измере-
ния I/Q (справа): сигнальное 
созвездие для указанного диа-
пазона поднесущей и PLP ID

-- Представление ошибки I/Q (рис. 
26): представление рассчитанного 
вектора ошибки между соответ-
ствующими точками символов в 
измеренном и эталонном сигналах 
I/Q

–– Представление зависимости 
MER/EVM от поднесущей/
частоты (вверху слева): рас-
считана по общим данным

–– Результаты декодирования 
сигнализации L1 (вверху 
справа)

–– Полярная диаграмма измере-
ния I/Q (внизу слева): сигналь-
ное созвездие для указанного 
индекса PLP

–– Метрики результатов (внизу 
справа): сводка результатов, 
рассчитанных для указанного 
индекса PLP

-- Представление АЧХ канала  
(рис. 27):

–– Зависимость амплитуды от 
поднесущей (вверху)

–– Зависимость фазы от поднесу-
щей (в центре)

–– Зависимость групповой 
задержки от поднесущей 
(внизу)

-- Представление импульсной 
характеристики канала (рис. 28): 
представление состояния канала, 
состоящее из двух окон:

–– Таблица пиковых значений 
(слева)

–– Импульсная характеристика 
канала (справа)

-- Представление сигнализации L1 
(рис. 29)

-- Представление мониторинга MER 
(рис. 30): мониторинг результатов 
MER во времени с регистрацией 
подробной информации и необ-
работанных данных для ошибок 
MER

-- Представление метрик результа-
тов (рис. 31): сводка метрик всех 
результатов
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Рис. 25. Представление измерения I/Q в полярных координатах

Примечание 1. Если выполняется 
измерение точности модуляции 
DVB-T/H, кнопка DVB-T2 становится 
серой. В этом случае перед измене-
нием радиостандарта нужно пере-
ключиться на другое измерение.

Примечание 2. В правом нижнем 
окне представления ошибки IQ 
пиковые значения EVM, MER, ошибки 
амплитуды и ошибки фазы ото-
бражаются как «---», поскольку в 
текущем PLP используется поворот 
сигнального созвездия.

Примечание 3. Если в представ-
лении монитора MER включена 
граничная линия (Meas Setup, 
More 1 of 2, MER Monitor) и текущее 
значение MER оказывается меньше 
этого предела, соответствующие 
необработанные данные IQ для этого 
измерения сохраняются в директо-
рии «D:\userdata\DVB-T2\rawdata» 
и могут использоваться буфером 
захвата анализатора сигналов серии 
Х для дальнейшего исследования. 
Кроме того, в процессе мониторинга 
создается файл журнала, включаю-
щий все значения MER, информацию 
о времени и путь к данным ошибки, 
который сохраняется в директории 
«D:\userdata\DVB-T2».

Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите тестируемый радиостандарт 
и ширину канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Активируйте измерение точности модуляции 
DVB-T2

[Meas] {DVB-T2 Mod Accuracy}

Настройте прибор на автоматическое опреде-
ление параметров демодуляции 

[Meas Setup] {Auto Detect} {On}

Синхронизируйте начало фрейма T2 входного 
сигнала DVB-T2 с внутренним периодическим 
запуском анализатора сигналов

[Meas Setup] {Sync Frame Now}

Выведите полярное представление измерен-
ных данных I/Q (рис. 25)

[View/Display] {IQ Measured Polar Graph}

Выведите результаты измерения ошибки I/Q и 
укажите индекс PLP для просмотра (рис. 26)

[View/Display] {I/Q Error (Quad View)}

Выведите АЧХ канала (рис. 27) [View/Display] {Channel Frequency Response}

Выведите импульсную характеристику кана-
ла и включите выравнивание (рис. 28)

[View/Display] {Channel Impulse Response} [Meas 
Setup] {Advanced} {Equalization On}

Выведите информацию о сигнализации L1 
(рис. 29)

[View/Display] {L1 Signalling}

Выведите результаты мониторинга MER (рис. 30) [View/Display] {More 1 of 2} {MER Monitor}

Выведите метрики результатов (рис. 31) [View/Display] {More 1 of 2} {Result Metrics}
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Рис. 26. Представление ошибки I/Q

Рис. 27. Представление АЧХ канала

Рис. 28. Представление импульсной характеристики канала
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Рис. 29. Представление сигнализации L1

Рис. 30. Представление мониторинга MER

Рис. 31. Представление метрик результатов
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Демонстрация 8

Паразитные излучения

Функция измерения паразитных 
излучений идентифицирует и опре-
деляет уровень мощности паразит-
ных излучений в частотных диапазо-
нах, определенных в стандарте ETSI 
EN 302 296. Это измерение может 
показать способность передатчика 
ограничивать помехи, вызванные 
нежелательным влиянием этого 
передатчика на другие системы, 
работающие на частотах, отличных 
от частоты несущей.

В анализаторах Keysight PXA/MXA/
EXA/CXA пользователь может сам 
настраивать диапазон частот, в кото-
ром выполняется поиск паразитных 
составляющих, и в результирующей 
таблице может отображаться до 200 
паразитных составляющих.

Примечание. Ошибочная точка на 
рис. 32 соответствует реальному 
передаваемому сигналу с централь-
ной частотой 474 МГц. Чтобы такого 
не возникало, можно настроить 
диапазон таблицы так, чтобы исклю-
чить полосу частот, содержащую 
передаваемый сигнал, или включить 
фильтр между передатчиком и 
приборами, чтобы подавить нежела-
тельный сигнал.

Примечание. Граничное значение 
может изменяться в зависимости 
от средней мощности передатчика. 
Поэтому перед измерением паразит-
ных излучений, установите среднюю 
мощность передатчика с помощью 
[Meas Setup] {CH Mean Power}.

Рис. 32. Измерение паразитных излучений

Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите тестируемый радиостандарт 
и ширину канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Активируйте маски излучаемого спектра [Meas] {Spectrum Emissions}

Установите среднюю мощность передатчика [Meas Setup] {CH Mean Power}

При необходимости отредактируйте таблицу 
диапазона

[Meas Setup] {Range Table}
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Демонстрация 9

Мониторинг спектра

Функция мониторинга спектра 
используется в качестве быстрого 
и удобного средства контроля всех 
спектральных составляющих. И 
хотя представление спектра в этом 
режиме очень напоминает режим 
анализатора спектра, функциональ-
ность его существенно ограничена с 
целью упрощения работы. Основное 
назначение этого измерения в том, 
чтобы показать спектр.

Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите тестируемый радиостандарт 
и ширину канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Активируйте мониторинг спектра [Meas] {Monitor Spectrum}

Рис. 33. Измерение сигнала с представлением ВЧ огибающей
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Демонстрация 10

Осциллограмма IQ

Измерение осциллограммы сигнала 
является измерением общего назна-
чения, предназначенным для иссле-
дования формы входного сигнала во 
временной области. Кроме того, это 
измерение выводит окно сигнала 
IQ, которое показывает зависимость 
уровня модулирующих сигналов I и 
Q от времени. Измерение осцилло-
граммы можно использовать и для 
точных универсальных измерений 
мощности.

Операции Нажатия клавиш

На анализаторе серии X в режиме DVB-T/H с T2:

Установите центральную частоту [FREQ Channel] {Center Freq} {474} {MHz}

Выберите тестируемый радиостандарт 
и ширину канала

[Mode Setup] {Radio Std} {DVB-T}
[Mode Setup] {Channel BW} {8 MHz}

Активируйте измерение осциллограммы IQ 
(по умолчанию ВЧ огибающая)

[Meas] {IQ Waveform}

Исследуйте форму сигнала IQ [View/Display] {I/Q Waveform}

Рис. 34. Измерение сигнала с представлением ВЧ огибающей

Рис. 35. Измерение сигнала с представлением сигнала I/Q
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